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 Windows Photo Editor & Video Editor

Take Off  (Page no. 11)
Do it yourself

Double Tap (Page no. 14)

Do it yourself.

	 Choose the correct option.

1. c. 	 2. a.	 3. d.	 4. c.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1. 	 2. 	 3. 	 4. 

A
Q 	 Answer the following questions:

1. �The Adjustments feature is used to remove the red eyes from a photo.
2. Storyboard is a horizontal bar containing various options to edit the video.
3. �Video editing means to add/remove some content in an existing video or apply some effects to 

the video.

	 Scratch Your Brain.

1. a. (iv)	 b. (i)	 c. (ii)	 d. (v)	 e. (iii)
2.	 Competency-based/Application-based questions:
	 a. Video editor
	 b. Windows Photo Editor

1.
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 Advanced Features of Word 2019

Take Off  (Page no. 25)

Double Tap (Page no. 28)

1. SPELLING
2. GRAMMAR
3. THESAURUS
4. REPLACE

	 Choose the correct option.

1. c. 	 2. c.	 3. d.	 4. c.	 5. d.

	 Fill in the blanks with the correct words.

1. Spell check	 2. Thesaurus	 3. Replace all	 4. Vertical	 5. Letter

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 	 4. 	 5. 

2.
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A
Q 	 Answer the following questions:

1.  �Orientation of a paper means the layout of the page in which the text or image appears, word 
has two types of page orientations Landscape and Portrait.

2.  �The Replace command replaces a specific word or text with other word or words in a document.
3.  �Mail Merge can send multiple letters and invitations to many people at the same time.
4.  �Step 1: Select the word.
   Step 2: Click on Review tab.
   Step 3: Click on the Thesaurus tool. 
   Step 4: Click on down arrow and select Insert or Copy.

	 Scratch Your Brain.

1.	 Write the keyboard shortcuts for the following actions:
	 a. F7
	 b. Shift + F7
	 c. Ctrl + F
	 d. Ctrl + H
	 e. Ctrl + Enter
2.	 Competency-based/Application-based questions:
	 a. She can change the orientation of the entire document. To do so, follow the given step:
	   Step 1: Click on Layout tab.
	   Step 2: Click on Orientation command.
	   Step 3: Choose Portrait or Landscape. 
	 b. �He can use Mail Merge feature in word by create and send multiple letters and invitations to 

many people at the same time.
	 c. �You can easily correct the mistakes by using the Spelling & Grammar tool. To check a document, 

follow the given steps:
	   Step 1: Click on Review tab.
	   Step 2: Select Spelling & Grammar tool.
	   Step 3: Double-click the word with the correct spelling.
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 More on PowerPoint 2019

Take Off  (Page no. 38)

1. T	 2. T	 3. F	 4. F

Double Tap (Page no. 45)

1. a. AIFF Audio (.aiff)
  b. AU Audio (.au)
2. d. .mp3

	 Choose the correct option.

1.  c.	 2. c.	 3. b.	 4. c.

	 Fill in the blanks with the correct words.

1. Audio on My PC	 2. Record	 3. Online video

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1. 	 2. 	 3. 	 4. 

A
Q 	 Answer the following questions:

1.  �Slide transition determines how your presentation moves from one slide to the next. PowerPoint 
provides several transition effects.

2.  Step 1: Click on File tab.
   Step 2: Click on the Print option.
   Step 3: Choose the desired print option.
   Step 4: Choose a layout to print.
   Step 5: Click on Print button.
3.  Step 1: Click on the Insert tab. 
   Step 2: Click on Video command. 
   Step 3: Click on Online Video option. 

3.
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   Step 4: Paste the URL of the video. 
   Step 5: Click on the Insert button.
4.  Step 1: Click on the Insert tab. 
  Step 2: Click on Audio command. 
  Step 3: Choose the desired option. 
  Step 4: Select the folder. 
  Step 5: Select the desired audio file. 
  Step 6: Click on the Insert button. 
  Step 7: Click on Play/Pause button to play or pause the audio.

	 Scratch Your Brain.

1.	 Identify the various animation effects category.
	 a. Emphasis
	 b. Entrance
	 c. Motion Paths
	 d. Exit
2.	 Competency-based/Application-based questions:
	 a. To create a PowerPoint presentation with recorded audio, follow the given steps below:
	   Step 1: Click on the Insert tab.
	   Step 2: Click on Audio command.
	   Step 3: Choose the desired option.
	   Step 4: Select the folder.
	   Step 5: Select the desired audio file.
	   Step 6: Click on the Insert button
	   Step 7: Click on Play/Pause button to play or pause the audio.
	 b. To add video in a presentation, follow the given steps:
	   Step 1: Click on the Insert tab.
	   Step 2: Click on Video command.
	   Step 3: Click on Video on My PC option.
	   Step 4: Select the folder from the explorer.
	   Step 5: Select the video file.
	   Step 6: Click on the Insert button.
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Periodic Assessment–1
(Based on chapters 1 to 3)

A.	 1. Spelling and Grammar
	 2. Thesaurus 
	 3. Find Tool
	 4. Replace Tool
	 5. Play button
	 6. Stop button
B.	 1. Rotating	 2. Flipping	 3. Slide Layout	 4. .mp4

C.	 1.  Click on the Insert tab.

	 2. Click on Video command.

	 4. Select the folder from the Explorer.

	 5. Select the video file. 

	 6. Click on the Insert button. 

	 3. Click on Video on My PC option. 

	 7.  Click on Play/Pause button to play or pause the video file.

 Introduction to Excel 2019

Take Off  (Page no. 52)
Do it yourself.

Double Tap (Page no. 54)

1. c.	 2. d.	 3. e.	 4. a.	 5. b.

4.
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	 Choose the correct option.

1. a. 	 2. a.	 3. c. 	 4. a.

	 Fill in the blanks with the correct words.

1. Spreadsheet	 2. Cancel	 3. Ctrl+S	 4. Formula bar

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1. 	 2. 	 3. 	 4. 

A
Q 	 Answer the following questions:

1. �When we make a change at one place in a worksheet, the entire spreadsheet is automatically 
recalculated.

2. The two components of Excel window are the following:
  a. �Ribbon: It contains different tabs. The tabs are divided into groups. Groups have commands 

tools and buttons. 
  b. Sheet Tab: It shows the number of worksheets in a workbook and the Active Sheet.
3. To create a new workbook, follow the given step:
  Step 1: Click on File tab.
  Step 2: Click on New option.
  Step 3: Click on Blank workbook.
4. To rename a worksheet, follow the given steps:
  Step 1: Right-click on the sheet tab
  Step 2: Select the desired option.

	 Scratch Your Brain.

1.	 Look at the given worksheet. write the cell addresses of the following:
	 a. A5	 b. C3	 c. A1	 d. B5	 e. B2	 f. D6
	 g. C4	 h. B7
2.	 Competency-based/Application-based questions:
	 a. Ctrl + S
	 b. Right click on the sheet tab and select the rename option.
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 Editing Cell Contents in Excel 2019

Take Off  (Page no. 62)
1. a.	 2. d.	 3. c.	 4. b.

Double Tap (Page no. 64)

1. Ctrl + A	 2. Shift + arrow	 3. Ctrl	 4. Ctrl + Shift + @

	 Choose the correct option.

1.  a.	 2.  d.	 3.  c.	 4.  d.

	 Fill in the blanks with the correct words.

1.  Cells	 2.  Column	
3.  [This question was printed incorrectly in the book. Please correct it in your textbook]
   Question:  ______________ command is used to erase the last change made by you.
   Ans: Undo
4. Delete	 5. Editing

A
Q 	 Answer the following questions:

1. The use of Redo command is used to redo the last Undo action.
2. �A range is a rectangular section of cells which are next to each other and at least one side of their 

border is common.
3. To copy the Data, follow the given steps:
  Step1: Select the cells you want to copy/move.
  Step2: Click on the Home tab.
  Step3: Select Copy command.
  Step4: Click on the cell where you want to copy/move. the selected range.
  Step5: Select Paste option.
4. �The purpose if AutoFill feature I Excel is used to automatically fill a series of data in rows and 

columns based on the values of other cells. To use the Autofill feature, follow the given steps:
  Step 1: Type the first number in a series.
  Step 2: Select the cell and the cells that you want to AutoFill.

5.
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  Step 3: Click on Click on Fill button.
  Step 4: Click on Series option.
  Step 5: Enter the Stop value.
  Step 6: Click on OK button.

	 Scratch Your Brain.

1.	 a. Fill	 b. Cut	 c. Paste	 d. Undo	 e. Redo	 f. Copy
2.	 Competency-based/Application-based questions:
	 Do it yourself.

Periodic Assessment–2
(Based on chapters 4 & 5)

A.	 1. It deletes the selected cells. The cells on the right are shifted to the left.
	 2. It deletes the selected cells. The cells below shift up.
	 3. It deletes the selected row. The row below shifts up.
	 4. It deletes the selected column. The columns on the right are shifted to the left.
	 5. The Cancel button is used to cancel the typing task.
	 6. This is Insert Function button.
	 7. The Enter button is used to insert the text.
B.	 1. View bar
	 2. Excel
	 3. Delete
	 4. Undo
	 5. Enter  

C.

	 View bar

Title barQuick Access Toolbar

Ribbon
File tab

Scroll bar
Columns

Sheet tab

Rows

Status bar

Name box

Active cell

Formula bar

Ribbon
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Test Sheet–1
(Based on chapters 1 to 5) 

A.	 1. c.	 2. a.	 3. c.	 4. b.	 5. c.	 6. c.
	 7. a.	 8. a.	 9. d.	 10. a.
B.	 1. Photos	 2. Rotating	 3. Spell check	 4. Thesaurus	 5. Audio on My PC
C.	 1. Formula bar
	 2. Print layout
	 3. Crop handles
	 4. Page formatting
	 5. Mail Merge
D.	 1. �The Adjustments feature is used to make minor changes or touch up blemishes in a photo like 

increase/decrease brightness and contrast of a photo, remove dark spots, increase/decrease 
clarity, remove red eyes and adjust the colours of a photo. 

	 2. �Video editing means to add/remove some content in an existing video or apply some effects 
to the video.

	 3. �Create the main document: The main document has the body of the letter or invitation that 
has to be sent. It contains merge fields. They are the places where data is inserted from the 
data source.

	 4. The steps to change the line spacing:
	   Step 1: Place the cursor anywhere in the paragraph. 
	   Step 2: Click on Home tab.
	   Step 3: Click on Line and Paragraph Spacing tool.
	   Step 4: Choose the line spacing you want.
	 5. Audio files inserted in a presentation, follow the given step:
	   Step 1. Click on the Insert tab
	   Step 2. Click on Audio command.
	   Step 3. Choose the desired option.
	   Step 4. Select the folder.
	   Step 5. Select the desired audio file.
	   Step 6. Click on the Insert button.
	   Step 7. Click on Play/Pause button to play or pause the audio.
	 6. To create a new workbook, follow the given step:
	   Step 1. Click on File tab. 
	   Step 2. Click on New option. 
	   Step 3. Click on Blank workbook.
	 7. �The purpose of AutoFill feature of Excel is used to automatically fill a series of data in rows 

and columns based on the values of other cells. To use the Autofill feature, follow the given 
steps:

	   Step 1: Type the first number in a series.
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	   Step 2: Select the cell and the cells that you want to AutoFill. 
	   Step 3: Click on Click on Fill button.
	   Step 4: Click on Series option.
	   Step 5: Enter the Stop value.
	   Step 6: Click on OK button.
	 8. To insert time in a cell, follow the given step:
	   Step 1: Select the cell where you want to edit the date or time.
	   Step 2: Click on Home tab.
	   Step 3: Click on the Number format dialog box launcher.
	   Step 4: Select Date option in the Category section.
	   Step 5: Choose the format you want.
	   Step 6: Click on OK button.

 Safeguarding your Computer

Take Off  (Page no. 76)
Do it yourself

Double Tap (Page no. 79)

1.  d.	 2.  b.	 3.  a.	 4.  c.

	 Choose the correct option.

1.  b.	 2.  d.	 3.  c.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1. 	 2. 	 3. 	 4. 	 5. 

A
Q 	 Answer the following questions:

1. �A malware is a type of malicious program designed to damage or carryout other unwanted actions 
on a computer system.

2. �A computer virus is a program that is able to copy itself when it is run. It gets activated each time 
the program or file to which it is attached is opened or executed.

6.
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3. a. �A trojan horse is a dangerous virus. It represents itself as helpful software programs. Once the 
user clicks on it to agree to run it, it gains access to sensitive data and then modifies, blocks, or 
deletes the data. It cannot copy itself from one computer to another.

  b. �An adware tracks user’s browser and download history and keeps popping advertisements on 
the screen. 

4. The two symptoms of an infected computer are:
  1. Change the file names or types automatically.
  2. Start displaying unusual messages on the screen.
5. We can protect our system from Malware attack, with the given points:
  1. Download only legal software.
  2. Use the original version of windows.
  3. Scan Pen drive, CD and any other external storage device for viruses before opening in computer.

	 Scratch Your Brain.

1.	 Do it yourself.
2.	 a. AVG	 b. Norton	 c. McAfee
3.	 Competency-based/Application-based questions:
	 a. Scan the Pen Drive 
	 b. He should not open an infected E-mail 

 Internet and E-mail

Take Off  (Page no. 84)

 	 Search information	 	 Take a bath 

 	 Find a recipie	  	 Download an image

	 Pack your bag	  	 Do shopping

Double Tap (Page no. 86)

1. Wi-Fi
2. Mobile Internet
3. Web Browser 
4. Internet 

7.
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5. Dial-Up Connection
6. Broadband Connection

	 Choose the correct option.

1. c.	 2. a.	 3. d.	 4. b.

	 Fill in the blanks with the correct words.

1. BCC	 2. To	 3. CC	
4. [This question was printed incorrectly in the book. Please correct it in your textbook]
   Question: A file can be inserted in an email by clicking on ____________________ button.
   Ans: Attach files 
5. Website

A
Q 	 Answer the following questions:

1. �Hotspots are sites that offer Internet access. It utilizes Wi-Fi technology, which allows computers 
to connect to the Internet. It is mainly used on smartphones.

2. �Wi-Fi uses radio frequency to connect to the Internet. Whereas Mobile Internet allows users to 
access the Internet over a smartphone provided with offers on voice plans with Internet access.

3. Step to open a Web page using URL, follow the given step:
 � To open a web page, type the URL in the browser's Address bar and press the Enter key from the 

keyboard.
4. �An Electronic mail or e-mail can be defined as the process of exchanging messages electronically 

through a communication network by using computer. To send an e-mail, follow the given step:
  Step 1: Click on the Compose button. 
  Step 2: Enter the details. 
  Step 3: Type the e-mail. 
  Step 4: Click on Send button.

	 Scratch Your Brain.
1. a. CC	 b. To 	 c. Subject	 d. BCC
2.	 Competency-based/Application-based questions:
	 a. He can attach music file through attachment.
	 b. �He can write Ajay's e-mail address in "To" field and others e-mail addresses in either CC field 

or BCC field.
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Periodic Assessment–3
(Based on chapters 6 & 7)

A.	 1. �Broadband is faster than the dial-up connection as it provides high-speed Internet through 
various transmission mediums. 

	 2. Dial-up connection is where you access internet using phone lines.
	 3. �Mobile Internet provides user to access Internet using a smartphone and network provided 

by service provider.
	 4. �An Electronic mail or e-mail can be defined as the process of exchanging messages electronically 

through a communications network by using computer.
B.	 1. Code Red Worm
	 2. Zeus
	 3. Emotet
	 4. Pegasus
C.	 1. (ii)	 2. (i)	 3. (iv)	 4. (iii)

 Data Processing

Take Off  (Page no. 96)
Do it yourself.

Double Tap (Page no. 99)

4%#32

	 Choose the correct option.

1. b.	 2. c.	 3. d.

A
Q 	 Answer the following questions:

1. �Data refers to the raw input. When this data is processed, the outcome received is known as 
information.

2. We can represent information, by given points:
  a. We can represent information in the form of tables, for example, class timetable.
  b. We can represent information in the form of pictures, drawing and so on. 

8.
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  c. We can represent information in the form of pictures, drawing and so on. 
  d. We can represent information in the form of pictograms, for example, road signs.
3. Data refers to the raw input and processed data is known as information.

	 Scratch Your Brain.

1.	 a.
2.	 Competency-based/Application-based questions:
	 a. He can sort his things.
	 b. By using Coded data.

 Conditional Blocks in Scratch

Take Off  (Page no. 102)
Do it yourself.

Double Tap (Page no. 105)

1. Ask block
2. Logical Operator block
3. Arithmetic Operator block
4. Relational Operator block

	 Choose the correct option.

1. a.	 2. b.	 3. b.	 4. a.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1. 	 2. 	 3. 	 4. 

	 Fill in the blanks with the correct words.

1. Logical operators	 2. Touching color	 3. Variables	 4. Repeat

9.
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A
Q 	 Answer the following questions:

1. �These blocks are colour-coded as light-green. Operators Blocks are used to do arithmetic and 
logical calculations. Blocks in the Operators category are oval and hexagon in shape.

2. For sensing an input, follow the given step:
  Step 1: Click on the Sensing block category.
  Step 2: Insert Penguin 2 sprite on the stage.
  Step 3: Delete the cat sprite.
  Step 4: Add Arctic backdrop to the stage.
  Step 5: Drag the ask block to the script area and click on it.
  Step 6: Type your name and click on the tick button or press the Enter key.
  Step 7: Type your name and click on the tick button or press the Enter key. 
  Step 8: Put the answer block in a say block. 
  Step 9: Type your name again and click on the tick button or press the Enter key.
3. If,then block: In this block if the condition is true, the blocks inside conditional block will run.
  If,then,..else block: In this block if the condition is true, the blocks inside then condition will run.

	 Scratch Your Brain.

1.	 Doit Yourself 
2.	 Competency-based/Application-based questions:
	 a. By using Arithmetic Operator block 
	 b. By using Repeat blocks 

	 Robotics

Take Off  (Page no. 114)

1.  Cooking food	  	 2.  Doing homework	 

3.  Cleaning room	  	 4.  Hurt feeling	

Double Tap (Page no. 116)

1. c.	 2. d.	 3. b.	 4. a.

10.
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	 Choose the correct option.

1. a.	 2. d.	 3. a.	 4. c.	 5. d.

	 Fill in the blanks with the correct words.

1. Security	 2. Nadine	 3. Shipwreck	 4. Space
5. Paro

A
Q 	 Answer the following questions:

1. �A robot is a type of automated machine that can execute specific tasks with little or no human 
intervention and with speed and precision.

2. �Surgical robots help doctors in performing surgery in healthcare field. Some of the humanoids 
can be a good companion to the recovering patients with serious illness.

3. a. Z-Machines
  b. Root 
4. �NASA has made a number of robotic devices to support or substitute astronauts to perform high 

risk tasks. Robonaut 2 or R2 was the first humanoid robot sent to space as a part of STS-133 mission.

	 Scratch Your Brain.

1.	 a. Paro
	 b. RoboThesain
	 c. Zenbo
	 d. Sophia
2.	 Competency-based/Application-based questions:
	 a. Do it yourself 
	 b. He can use Moley Robotic Kitchen.

Periodic Assessment–4
(Based on chapters 8 to 10)

A.	 1. Logical Operators
	 2. Arithmetic Operators
	 3. Sensing Blocks
B.	 1. T-HR3	 2. Sophia	 3. RoboThespain
	 4. Nao	 5. Paro	 6. Z-Machines 
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C.	 1. A Script can be made by Sensing blocks.
	 2. Sophia is the first humanoid to receive citizenship of a country.
	 3. �RoboThespain is an actor that comes with a library of impressions, greetings, songs and 

gestures.
	 4. In scratch, a program is called a Script.
	 5. Zenbo is a low-cost robot capable of rolling around freely. 
	 6. Arranging data in a specific order is known as Sorting.

Test Sheet–2
(Based on chapters 6 to 10)

A.	 1. b.	 2. c.	 3. d.	 4. b.	 5. c.	 6. b.
	 7. b.	 8. d.	 9. a.	 10. c.
B.	 1. Antivirus	 2. ILOVEYOU	 3. To	 4. Shipwreck	 5. Ask
C.	 1. Paro	 2. Nadine	 3. Script	 4. Root	 5. Light-green
D.	 1. �A malware is a type of malicious program designed to damage or carryout other unwanted 

actions on a computer system.
	 2. �A computer virus is a program that is able to copy itself when it is run. It gets activated each 

time the program or file to which it is attached is opened or executed. 
	 3. �NASA has made a number of robotic devices to support or substitute astronauts to perform 

high risk tasks. Robonaut 2 or R2 was the first humanoid robot sent to space as a part of STS-
133 mission.

	 4. �An Electronic mail or e-mail can be defined as the process of exchanging messages electronically 
through a communication network by using computer.

	 5. Decoding 
	 6. We can represent information, by given points:
	   a. We can represent information in the form of tables, for example, class timetable.
	   b. We can represent information in the form of pictures, drawing and so on.
	   c. We can represent information in the form of pictures, drawing and so on.
	   d. We can represent information in the form of pictograms, for example, road signs.
	 7. If,then block: In this block if the condition is true, the blocks inside conditional block will run.
	 �  If,then,..else block: In this block if the condition is true, the blocks inside then condition will 

run.
	 8. For sensing an input, follow the given step:
	   Step 1: Click on the Sensing block category.
	   Step 2: Insert Penguin 2 sprite on the stage.
	   Step 3: Delete the cat sprite.
	   Step 4: Add Arctic backdrop to the stage.
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	   Step 5: Drag the ask block to the script area and click on it.
	   Step 6: Type your name and click on the tick button or press the Enter key.
	   Step 7: Type your name and click on the tick button or press the Enter key.
	   Step 8: Put the answer block in a say block.
	   Step 9: Type your name again and click on the tick button or press the Enter key.


